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1 What’s New in Logic Pro 7.1

This document contains information about the 
improvements and changes found in the 
Logic Pro 7.1 Update.

The descriptions in this document supersede the relevant sections of the Logic Pro 7 
manuals (including the Late-Breaking News.pdf ). For the latest information about 
product updates, tips, and techniques, visit the Logic Pro website at 
http://www.apple.com/logic.

General Improvements
The Logic Pro 7.1 Update introduces the following general enhancements. 

Plug and Play of Audio Interfaces
Logic Pro 7.1 supports plug and play for audio interfaces:  it’s possible to connect and 
switch on a new/additional audio interface while Logic Pro 7.1 is running. An alert 
appears when you connect a new device, and will prompt you to select and confirm 
the audio interface/driver that you would like to use. 

http://www.apple.com/logic
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Changes to Dialogs
A number of enhancements have been made to the following Logic dialogs:
• Sample Editor:  Audio File > Save Selection As, Audio File > Save a Copy As. Both 

dialogs now allow you to set the desired sample rate, stereo conversion and dither 
type for the destination file. The dialogs also feature an additional “Add resulting files 
to Audio window” option. 

• Audio window:  Audio File > Save Region As, Audio File > Copy/Convert File As: Both 
dialogs offer the file conversion menus outlined above for the Sample Editor, 
enabling one or multiple selected Regions/files to be converted or copied. The Copy/
Convert File As dialog provides an additional “Add resulting files to Audio window” 
option.

• Arrange window:  The Audio > Convert Regions to New Audio Files dialog provides 
the file conversion menus outlined above for the Sample Editor.

• The global File > Export > Region as Audio File dialog offers an additional “Add 
resulting files to Audio window” option. 

• Project:  The File > Save as Project dialog and File > Project > Consolidate dialogs 
contain new Ultrabeat sample handling options. The pull-down menu choices 
include:  Leave, Move, or Copy. These work in the same fashion as the Audio Files, 
Sampler Instruments and Samples pull-down menu options. Please see the 
Logic Pro 7 Reference Manual for details.

Some file dialogs now 
feature additional file 
conversion settings. 



 3

  

Beat Mapping Track
The global Beat Mapping track helps to make the display of audio or MIDI recordings 
rhythmically meaningful. It does this by defining the bar positions of existing musical 
events without changing their absolute time position, thus preserving their timing.

On occasion, this behavior may not be desirable. As an example, for existing MIDI 
events that already fall on musically useful positions, and should remain there when 
beat mapping is used for audio recordings. 

Such situations are catered for by the inclusion of the new Protect MIDI checkbox, 
found in the Parameters area of the Beat Mapping track. Simply activate this checkbox 
to keep existing MIDI events at their current positions when using beat mapping.

Chord Track
The chord symbols displayed in the Chord track can now be inserted into the Score 
Editor (and printed):

To insert chords from the Chord track into the Score Editor:
m Select the staff that you would like to use for the chord symbols in the Score Editor and 

choose Functions > Insert Chords from global Chord track.

Inserted chord symbols are displayed in blue (printout will be black), and can only be 
moved within the boundaries of the chord on the Chord track. Double-clicking such a 
chord will launch the Define Chord dialog of the Chord track.
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Marker Track
If you create markers from Regions (by dragging a Region from an Arrange track onto 
the Marker track or by pressing the From Region button in the Marker track, for 
example), the corresponding marker now uses the Region color. 

Limited Cycle Dragging
Dragging the Cycle area in the Bar Ruler is now limited to either horizontal or vertical 
movements. This ensures that you do not accidentally:
• move the Cycle area if you want to create markers (by dragging the Cycle area into 

the lower third of the Bar Ruler or into the Marker track).
• create markers if you want to move the Cycle area. 

Note:  Press Shift if you want to drag the Cycle area in both directions simultaneously.

Arrange Region Handling
The handling of Regions in the Arrange window has been improved:  selected Regions 
that overlap with unselected Regions are now shown “on top.”

Additional Key Commands
Logic Pro 7.1 offers several key commands for functions previously only accessible as 
menu items.

Global Menu Functions
The following global menu functions are now also available as key commands:

Application (Logic) menu: 
• Opening all preferences windows, the Logic Setup Assistant, and the AU Manager 
• Initialize All except Key Commands function

File menu
• Project functions:  Project Settings, Clean Up Project, Consolidate Project, Rename 

Project, Save as Project
• Opening all panes of the Song Settings window
• Save functions:  Save a Copy As, Save a Template As
• Export functions:  Region as Audio File, Track as Audio File, All Tracks as Audio Files, 

Song as OMF File, Song as OpenTL File, Song as AAF File, Song to Final Cut Pro/XML
• Bounce function
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Audio menu
• Import Audio File
• Opening Loop Browser, EXS 24 Instrument Editor, Hardware and Drivers pane, 

Surround preferences pane, and TDM DSP Usage window
• Toggle Punch on the Fly
• Toggle Pre Fader Metering

Options menu
• Markers:  Create by Regions, Quick Edit Marker
• Track Automation: Toggle Automation Quick Access, Delete Orphan Automation Date 

of Current Track
• Movie:  Open Movie as Float, Extract Audio from Movie, Extract Audio to Arrange, 

Export Audio to Movie, Find Scene Cuts, Remove Scene Markers

Windows menu
The Step Input Keyboard can now be accessed via a key command.

Arrange Menu 
The following local Arrange menu functions (Arrange window) are now also available 
as key commands:
• Track:  Create Multiple, Delete Redundant Audio Tracks
• Region: Unpack Folder (Use Existing Tracks), Demix by Note Pitch
• MIDI: Select all Orphan Aliases, Delete all Orphan Aliases
• Audio: Open in Apple Loops Utility, Copy ReCycle Loop, Paste ReCycle Loop, Search 

Zero Crossings

Hyper Editor 
The following local Hyper Editor functions are now also available as key commands:
• Create Hyper Set
• Create GM Drum Set
• Create Hyper Set For Current Events
• Clear Hyper Set

Track Mixer
All Filter buttons can now be switched on and off via key commands.

Channel Strip Settings Menu
The following key commands have been added:
• Next/Previous Channel Strip setting
• Save/Copy/Paste Channel Strip setting 

Note:  Logic Pro 7.1 also features the new, more general “Next/Previous Channel Strip 
Setting or Plug-in setting or EXS Instrument” key commands.
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Snap and Drag Menu
All Snap and Drag menu entries can now be chosen via key commands.

Audio window
Groups can now be created or deleted via corresponding key commands. 

New Key Command Warning
In circumstances where an existing local key command combination is used when 
assigning a new global key command, the following warning message will appear:  
“This shortcut is already assigned to key command xxx in key command class yyy, which 
has higher priority than key command class zzz.” You have three options:  Cancel, 
Replace, or OK. Cancel does not alter existing assignments. Replace will replace the 
existing shortcut assigned to the chosen key command combination with the selected 
function. OK will assign the key command combination to the selected function while 
retaining the existing key command/function.

Important:  There is a hierarchy of key command classes, which are not merely 
separated into global and local key commands. As an example, there is a key command 
class that applies to all windows that display Regions. This class has higher priority than 
global key commands, but a lower priority than local (Arrange, Score, Matrix, and so on) 
window key commands.

XML Import
The XML import procedure now allows you to retain the sample rate of audio files used 
in your Final Cut sequences. If you import sequences that use audio files with different 
sample rates, the following dialog appears:  “The selected Final Cut sequence contains 
audio files with different samples rates. The current Logic sample rate A requires x 
audio files to be converted (xxx MB disk space required). Switching the Logic sample 
rate to B requires y audio files to be converted (yyy MB disk space required).” You can 
then choose if you would like to change or keep the sample rate of your Logic project. 
All Final Cut sequence audio files that use a sample rate that differs from the selected 
one are converted.

Note:  In Final Cut, a sequence is an arranged series of video, audio, and graphics clips, 
edit information, and effects, combined to create a movie. This is unrelated to the 
former use of the term “sequence” in Logic, which referred to MIDI Regions. Use of XML 
to import Final Cut sequences into Logic allows you to exchange at once multiple 
audio tracks, with all positional region information, region names, volume and pan 
automation data, retained. 

Removing Movie Function
The Options > Movies menu now features a Remove Movie function, which allows you 
to completely remove a movie from a song or project. All references to the movie in 
the project or song are deleted. 
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Hidden Menu Bars in Screensets
Logic Pro 7 allows you to hide local menu bars and scroll bars by Option-Command-
clicking the title bar.

The Logic Pro 7.1 Update enhances this function. It now also works when using 
Screensets:  You can save the state of hidden menu bars and scroll bars in Screensets. 
Hidden menu bars and scroll bars are also saved when you close a window. As an 
example:  Hide the menu bar and scroll bars of the Arrange window and close it. When 
you reopen the Arrange window, the menu bar and scroll bars remain hidden.

This function is handy in situations where you would like to configure small floating 
Environment windows containing Fader Objects, used as switches, for example.

Bounce Dialog
Choosing the CD burner
The Bounce dialog in Logic Pro 7.1 offers a new Device menu in the Burn options, which 
allows you to choose between any recognized CD burners connected to your system. 
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Start and End Position default values
The default values for the Start and End Position fields in the Bounce dialog now also 
take selections made in the Arrange window into account. 

This means that the default values are now set in the following way:
• If the Cycle function is engaged, they will be set to the locator positions. 
• If a selection is made in the Arrange window, they will be set to the selected area.
• If neither of the above is valid, they are set to encompass the entire Logic song. 

Faster Overview Creation
The Overview Creation dialog features an additional option which accelerates overview 
creation. This option makes the overview creation as fast as the “foreground” overview 
creation of Logic 6 (at the cost of slowing down other operations, but not blocking user 
interaction completely).
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Follow Tempo Function
Audio files created in Logic Pro 7.1 can now follow the song tempo (including tempo 
changes) and the first key signature set in the Global tracks.

As an example:  If you record a bass solo at 100 bpm, you can change the song tempo 
to 120 bpm and the bass solo will automatically be played back at the new tempo. 

The function works with all audio files that were recorded in, or bounced/exported 
from, Logic Pro 7.1. The function only works in the parent song (the song the audio files 
were created in). If you drag a file recorded in a given song to another song with the 
Finder, the file can not follow the song tempo. Bounced/exported files can only follow 
the song tempo, if the “Add resulting files to Audio window” option was enabled in the 
Export/Bounce window prior to the bounce/export. Files copied between two songs 
retain the ability to follow the song tempo. 

The song's tempo information is used to tag the beats in the recording. The function 
works best if your audio files match the song tempo as precisely as possible. The longer 
your audio files are, the more RAM is required for this functionality to work properly. 

If you want your audio files to follow the song tempo and key, you will need to select 
the appropriate Audio Region in the Arrange window and enable the Follow Tempo 
option in the Region Parameter box. The Follow Tempo option is synchronized for all 
Regions that make use of the same audio file.

All audio files that follow the song tempo and first key signature are indicated by the 
following symbols in Logic:

Note:  The Follow Tempo option does not create an Apple Loop! Remember: Apple 
Loops follow chord changes—should you record a solo over an arrangement consisting 
of Apple Loops with transposition changes over time, you might want to enable Follow 
Tempo for your solo, but you won’t be happy with the double transpositions that will 
occur…

To create an Apple Loop, please use either of the following options:
• Choose Region > Add to Apple Loops Library in the Arrange window (also see the 

ensuing section). This method sets transients that are based on the song’s tempo 
information.

• Choose Audio > Open in Apple Loops Utility in the Arrange window (more 
information can be found in the Logic Pro 7 Reference Manual). This functionality 
allows you to set the transients manually—independent of the song tempo. 
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Apple Loops
The following changes have been made to Apple Loops handling.

Creating Your Own Apple Loops
You can now directly save both Audio and Audio Instrument Regions as Apple Loops in 
Logic Pro 7.1. When you save a Region as an Apple Loop, it is added to the loop library 
and appears in the Loop Browser, allowing its use in other songs. 

Note:  The tempo information from the song is used to tag the transients in the Apple 
Loop. This function works best if your audio files match the song tempo as precisely as 
possible.

User-created Apple Loops behave exactly like the Apple Loops that ship with Logic, 
GarageBand, or Jam Packs:  They follow the tempo of your song and match the song 
key (as defined by the initial key signature).

To create an Apple Loop:
1 Select the Region in the Arrange window. 

2 Choose Region > Add to Apple Loops Library in the local Arrange menu.

3 In the Add Loop dialog: 

• Type in a name for the loop, choose the scale, genre, instrument category, 
instrument name, and the appropriate mood descriptions—to simplify searches.

• Set the file type, which can be One-shot or Looped. If the length of your Region does 
not match the beats, One-shot is selected automatically, and the file type buttons are 
dimmed.

Note:  One-shots do not follow the song tempo and key. This is useful if you want to 
add discrete, non-musical sounds (such as sound effects) to the loop library, which 
should not be altered by the tempo and key properties. 

4 Click Create.
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The loop is added to the Loop Browser. You can find it by using the keyword buttons, 
menus, or by typing the name in the Search field. If you drag the loop into the Arrange 
window, the Apple Loops symbol is shown beside the file name. As one-shots are 
handled like normal audio files, the usual stereo or mono Region symbol is shown 
alongside the file name (rather than the Apple Loops symbol).

Creating Apple Loops from Split Stereo Files
Logic Pro 7.1 allows you to create Apple Loops from split stereo files that are placed on 
UTM stereo tracks. The split stereo file must first be converted to an interleaved stereo 
file. When you add the Region to the loops library or open it in the Apple Loops Utility, 
a dialog will ask if you want to convert the file. Confirm this by pressing Convert. 

Importing ReCycle Files as Apple Loops
You can import ReCycle files into the Arrange window as Apple Loops. To do so, simply 
choose the “Render to Apple Loop” option in the Fix menu of the ReCycle File Import 
dialog.

Alternatively, you can use the Project Manager’s Batch Convert function to 
simultaneously convert multiple ReCycle files into Apple Loops. Simply select the 
desired ReCycle files in the Project Manager and choose Functions > Convert selected 
REX files to Apple Loops. The slice points are converted to transient positions.

Sample Rate Conversion of Apple Loops
Apple Loops can now also be sample rate converted, including correction of transient 
positions.

Usage example:  If you change the sample rate of your song by choosing Audio > 
Sample Rate > … from the main menu bar, all Apple Loops currently used by your 
song will automatically be converted to the newly selected sample rate.

Advanced Loops Management
The Loop Browser in Logic Pro 7.1 allows you to limit the display to loops from a specific 
Jam Pack, if you have one or more Jam Packs installed on your computer.

Simply select the desired option from the Jam Pack Management menu. You can 
choose between:
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• Show All:  Choose this default option to display all Apple Loops on your system. 
• My Loops:  Choose to display all Apple Loops in the ~/Library/Audio/Apple Loops and 

~/Library/Application Support/GarageBand folders (~ denotes the User name).
• Shared Loops on my Mac:  Choose to display all Apple Loops in the /Library/Audio/

Apple Loops and /Library/Application Support/GarageBand folders.
• GarageBand:  Choose to display all Apple Loops installed with GarageBand.
• Jam Pack x:  Choose to display all Apple Loops from a specific Jam Pack. 
• Vendor x:  Choose to display all Apple Loops from a specific third-party vendor.
• Other:  Choose to display all loops that you added to the loop library by dragging 

them into the Loop Browser.

Updated File Path for Apple Loops
Logic Pro 7.1 uses a new location for any associated Apple Loops installations.

/Library/Audio/Apple Loops
Used for any Apple Loops libraries that ship with Logic Pro 7.1. This folder is also used 
for GarageBand versions higher than 2.0 and any additional Jam Pack libraries (higher 
than volume 4).

~/Library/Audio/Apple Loops/User Loops 
Used for user-created Apple Loops.

Note:  All Apple Loops libraries that were released before Logic Pro 7.1 (including the 
libraries that ship with Logic Pro 7 and GarageBand 1, as well as Jam Pack libraries 
volumes 1 to 3) will use the following installation folder:  /Library/Application Support/
GarageBand. All Apple Loops that are already on your system, will remain in their 
original locations. For more information, please refer to the Logic Pro 7 Late-Breaking 
News. 

Export as Audio File Functions
The Export Audio File functions have been enhanced in the following ways:
• All Export As Audio File dialogs (Export > Track as Audio File, Export > Region as 

Audio File, Export > All Tracks as Audio files) feature an additional “Add to Audio 
window” option. This option allows you to automatically add the exported audio 
file(s) to the song’s Audio window.

• The naming mechanism of the Export > Tracks as Audio Files function has changed:  
All files are named after the corresponding Audio Object and track name (“Audio 
Object Name–Track Name.filetype extension” or simply “Audio Object Name.filetype 
extension” if no track name has been specified). If the resulting file name is longer 
than 31 characters, the naming components are abbreviated. When choosing File > 
Export > Track as Audio File, a name based on the selected track’s name and Audio 
Object is created as the default name in the save dialog.
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Control Surface Support
In order to keep the Control Surface support current, the following control surfaces 
have been added:
• Tascam US-2400
• Tascam FW-1082
• Frontier TranzPort
• JL Cooper CS-32
• JL Cooper FaderMaster 4/100
• Korg microKONTROL
• Korg KONTROL49

Note:  For further information about the individual control surfaces, please refer to the 
Control Surfaces Support document—found in the Documentation folder on the 
Logic Pro 7 Installation DVD. 

Modal Dialogs Display
All modal dialogs (except file selector boxes) are now shown on control surfaces that 
feature text displays.

All text fields are shown in the display’s upper row. If the dialog text does not fit into 
the LCD’s upper row, it will start scrolling after three seconds. You can scroll the dialog 
text manually with the appropriate control (see assignment tables in the Control 
Surfaces Support document). Once you start doing so, automatic scrolling is disabled. 
• If there is an Enter or OK button on the control surface, it triggers the dialog’s default 

button, where applicable. 
• If there is a Cancel or Exit button on the control surface, it triggers the button labeled 

Cancel or Abort, where applicable. 
• All buttons (push buttons, including Enter/default and Cancel, as well as checkboxes 

and radio buttons, but not pop-up buttons) are shown in the display’s lower row. 
Pressing a control surface button below the display triggers the appropriate button/
function in the dialog, if applicable. 

Following use of the Enter/Cancel button on the control surface or with the mouse, the 
dialog will disappear, and all controls and displays will return to their previous state. 

Mackie Control Mode Support
Logic Control, Logic Control XT, Mackie Control Universal and Mackie Control Extender 
(all with firmware version 1.02 or higher) no longer need to be switched to Logic 
Control mode, to be recognized by Logic. 

If you use software that requires Mackie Control mode:
1 Switch to Mackie Control mode. (Details can be found in your control surface 

documentation).

2 Delete the Logic Control control surface in the Control Surfaces Setup window.
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3 Turn on the power for your control surface. It will automatically be installed as a Mackie 
Control. The functionality of both modes (Mackie Control/Logic) is identical. 

Note:  If you do not use software that requires Mackie Control mode, you shouldn’t 
change anything.

Deleting Control Surface Assignments
As a further productivity enhancement, you can now delete the selected assignment, 
zone, or mode with the backspace key—or you may use the Edit > Clear menu option 
that was available in earlier versions.

Learning Control Surface Assignments 
When the Controller Assignment window is opened in Expert view, any newly-created 
assignments will become part of the currently displayed Mode. When not in Expert 
view, the assignment is created in the No Zone section, which contains assignments 
that are always active.

Project Manager
The Project Manager features an additional “Copy selected EXS Instruments and used 
samples” function. To use this option, select the desired EXS Instrument in the Project 
Manager and choose Functions > Copy selected EXS Instruments and used Samples. A 
dialog opens, asking you to choose a destination folder for the copied Instruments and 
samples. Simply select, and save.

This function is handy in situations where you would like to use a smaller palette of 
Sampler Instruments from your big studio library on your PowerBook, for example.

Mixer Windows
The following enhancements have been made to the Mixer windows.

Multiple Selection of Channel Strips
The Multiple Selection function of channel strips in the Mixer windows has been 
enhanced:  Clicking a channel background (without Shift held) now also allows you to 
select further channels by dragging over them (in the background).
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Surround Pan Window
Logic Pro 7.1 enhances the Surround Pan windows in the following ways:

• It is possible to open multiple Surround Pan windows simultaneously. 
• You can save Surround Pan windows in Screensets. 
• The Surround Pan window now provides a Link button. If enabled, the window will 

always show the surround setup status of the selected Audio Object.

Hand Tool in Track Mixer and Arrange Channel Strip
The Track Mixer now offers a Hand tool, which can be used to move and copy plug-ins 
between channel strips.

Note:  The Track Mixer’s Hand tool is identical to the Audio Configuration window’s 
Hand tool. All enhancements described below also apply to the Audio Configuration 
window Hand tool, and supersede the corresponding information in the Logic 
manuals.

To move a plug-in between two Insert slots:
1 Select the Hand tool in the Track Mixer’s Toolbox by clicking it. 

2 Select the plug-in label and drag it to the desired target slot. 

During the drag and drop operation, the potential destination is displayed as an orange 
rectangle (empty slot) or line (when placing an effect between two Insert slots, see 
below). Pressing Option during dragging copies the plug-in. 

You can also use the Hand tool in the Arrange window’s channel strip by pressing 
Command (or right-clicking) when the cursor hovers over the Instrument or Insert slot.
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Note:  The Hand tool is the second default tool in the Track Mixer. Pressing Command 
while clicking enables you to switch from the Pointer tool to the Hand tool. This allows 
you to move plug-ins by Command-dragging them, and to copy them by Option-
Command-dragging them. 

If you drag a plug-in label onto a used plug-in slot in the same channel strip, the plug-
ins are swapped. When dragged between different channel strips, the existing plug-in 
is replaced. 

Placing Effects Between Insert Slots
If you drop an effect between two used Insert slots, the effect is inserted into a new 
slot between the two used slots. The effects below are shifted down by one slot.

If the effect’s source location is above the destination location, all plug-ins between the 
source and destination locations are shifted up one position. If the plug-in’s source 
location is below the destination location, all plug-ins between the source and 
destination locations will be shifted down one position.

Note:  If all 15 Insert slots are used, you can not place effects between Insert slots. 
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Plug-ins
The following plug-in enhancements have been made in Logic Pro 7.1.

Plug-in Delay Compensation
The Logic Pro 7.1 Update features plug-in delay compensation on busses, auxes, 
outputs, and ReWire Objects. A new pop-up menu has been added to the Preferences 
> Audio > General pane, which allows you to activate plug-in delay compensation for 
either:
• Audio tracks and instruments (This option ensures compatibility with earlier Logic 

songs).
• All (Audio Track, Instrument, Bus, Aux, ReWire and Output Objects).

Ultrabeat 
The Logic Pro 7.1 Update enhances Ultrabeat’s functionality in the following areas. 

Drag and Drop Functionality
Swapping or copying drum voices within a kit, or integrating drum voices from an 
imported kit was previously achieved with a copy and paste operation via a shortcut 
menu. The same tasks can now also be performed with a drag and drop operation, 
enhancing workflow and ease-of-use.

To swap/copy drum voices using drag and drop:
1 Click-hold the drum voice in the assignment section (not on a button or menu).

2 Drag and drop it to the desired position. 

• A simple drag and drop swaps the two drum voices, without sequences. 
• Holding Command during the drag and drop operation swaps the two drum voices, 

including sequences.
• Holding Option during the drag and drop operation copies the voice, without its 

sequences.
• Holding Option-Command during the drag and drop operation copies the voice, 

including all of its sequences.

Note:  You can also use drag and drop to transfer drum voices and sequences from the 
Import List to the Mixer section. Holding Command while doing so includes all 
sequences. Swapping is not available in this context.
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Copying Patterns in the Pattern menu
Copying patterns was previously achieved with a copy and paste operation via a 
shortcut menu. The same tasks can now also be performed with a short cut, enhancing 
workflow and ease-of-use.

To copy a pattern using the short cut:
1 Select the desired pattern in the Pattern menu. 

2 Press Option and select another Ultrabeat pattern. The selected pattern is copied to the 
target position. 

All sequencer data that exists in the new pattern number is replaced. If you change 
your mind during the process, simply release Option.

Exporting Step Sequences as MIDI Regions
Step sequences programmed in Ultrabeat’s internal step sequencer can now also be 
exported as MIDI Regions into Logic’s Arrange window.

To export an Ultrabeat sequence to the Arrange window:
1 Select the desired pattern in Ultrabeat’s Pattern menu.

2 Click-hold the area to the left of the pattern menu.

3 Drag and drop the sequence at the desired position on the respective Ultrabeat track. 
A Region is created, containing all MIDI events, including Swing and Accent parameter 
settings. MIDI notes are positioned according to their Swing value set in Ultrabeat. 
Accents are interpreted as polyphonic pressure events.

Note:  To avoid double triggering while playing back the exported MIDI Region, you 
may want to turn off Ultrabeat’s internal sequencer. 

Previewing Samples in Sample Load Window
Ultrabeat offers a new Play button in its Load Sample dialog, which allows audio files 
(AIFF, WAV, SD2, UBS) to be previewed before loading. 
• Press the Play button to loop playback of the currently selected sample file. The 

sample is played directly from the hard disk, with no voice manipulation:  filters, EQ, 
envelopes, and other synthesizer parameters are ignored.

• Pressing the button again stops playback.

You can audition multiple files by pressing Play once, and then stepping through the 
files.
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Note:  In the case of multi-layer UBS files, the sample is played with a fixed velocity of 
75%. Independent auditioning of all layers is not possible. Only the layer addressed by 
this Velocity value will be played.

Preview Sample in Ultrabeat Voice function
The “Preview Sample in Ultrabeat Voice” option temporarily replaces the sample files 
(AIFF, WAV, SDII, UBS) in the currently selected voice. The voice is not directly triggered 
by activating this option, but it can as usually be triggered via MIDI notes (played 
notes, MIDI Region events or Ultrabeat sequencer events) while the File window is 
open and different files are being selected. The selected sample can be heard as part of 
the current drum voice, inclusive of all synthesizer processing. Once you find a sample 
you’d like to use, click Open to load it. Click Cancel to return to the previously loaded 
sample. 

Note:  Any effects inserted into the Ultrabeat instrument channel affect previews. 

Modulation Target Display of LFOs and Envelopes
Ultrabeat’s user interface now features a function that makes finding the modulation 
targets of the LFOs and envelopes faster:  Simply press the numerical field of the 
desired modulation source to highlight all of its modulation targets. 

Sculpture
Enhanced string animation
Sculpture’s string animation has been enhanced:  it now shows the range of the string’s 
motion, rather than its momentary position. 

Morph position display
Sculpture’s Morph Pad displays a moving dot that indicates the current morph position, 
during a morph. The red line in the Timeline below shows the current time position.

Note:  The current morph position is shown as long as only one note is played. 

Click here to highlight all 
modulation targets of 
Envelope 1.

Highlighted modulation 
target of Envelope 1

The dot and line indicate
the current morph

position.
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EVB3
The following enhancements to the EVB3 are available.

MIDI Modes Menu
The MIDI Mode menu offers the additional NE option, which enables the EVB3 to 
respond to control change messages from Clavia’s Nord Electro II keyboard.

The HS option has been enhanced:  In addition to the existing drawbar support, you 
can now also use the following controls of the Hammond Suzuki XB-1, XK-2, and XK-3 
to remotely control your EVB3:
• Leslie:  Brake/On/Fast
• Vibrato and Chorus
• Percussion (2nd/3rd/soft/fast)

New On/Off Button in Rotor Cabinet Section
The Rotor Cabinet section now offers an On/Off button, allowing you to disable the 
Leslie simulation directly (instead of choosing the Off option in the Cabinet menu).

Additional Parameters in 001/011 View
Activation of the 001/011 button accesses several additional parameters.

Any differences in volume (between the Leslie and organ signals) can now be adjusted 
with the Dry Level parameter. This parameter allows you to adjust the level of the dry 
signal, which can also be useful if the “Switches to dry sound” option is selected in the 
Brake menu, found below.

The Brake menu offers two options that allow you to modify the EVB3’s Brake mode: 
• Stops rotor—In this mode, the Brake mode works as it did in earlier Logic versions:  

The movement of the rotor is gradually slowed down to a total stop.
• Switches to dry sound—In this mode, the rotor cabinet is bypassed when stopped, 

with a delay time of one second. This is useful if using the modulation wheel to 
switch between the Tremolo (fast rotor speed) and Chorale (slow movement) modes. 
If you then switch to Brake mode, the rotors are slowed down during the transition 
to the dry sound.

The Bass menu allows you to imitate the non-foldback bass behavior of the first 
Hammond organ ever made, the model A. This model had no foldback for the 16' 
drawbar in the lowest octave, with the bottom twelve tone generator outputs available 
on the first drawbar of the manuals’ bottom octave. On other console organs, the 
lowest twelve tone generator outputs are only available on the pedals. To simulate the 
behavior of the Hammond Model A, choose the “All the way down” option in the Bass 
menu. Without foldback, you’ll find that the sound is more strident, and similar to the 
pedal sound, especially if you’re not using a real Leslie cabinet when playing the EVB3. 
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When using a two drawbar hardware controller, the Drawbar affects menu offers an 
additional mode that allows Hammond-like switching between two registrations. If you 
use the default setting (“Drawbar affects current preset key”), the drawbars will always 
change the registration of the currently active preset registration key. This works 
differently in a “real” Hammond organ, where the drawbars only affect the Bb (upper 
manual) and B (lower manual) preset registrations. This allows the player to prepare a 
new registration with the drawbars while playing, and then switch to the new 
registration as desired. 

This behavior can now also be simulated with the EVB3:
1 Choose the “Only B & Bb key” option in the Drawbar mode menu. This option enables 

the upper manual drawbars to change the registration of the Bb preset key, and the 
drawbars of the lower manual affect the B preset key. 

2 Change the drawbars of the Bb preset key as desired. You can freely play the keyboard 
while doing so, without changing the currently chosen registration. 

3 Switch to the prepared registration with the Bb preset key. 

The Reverb menu allows you to patch the reverb effect before (Pre option) or after 
(Post option) the rotor effect. 

The Upper/Lower Stop Position sliders have been renamed Horn Brake Pos and Drum 
Brake Pos. 

EXS24 mkII
The Logic Pro 7.1 Update enhances the EXS24 mkII in the following ways.

Loading multiple samples in the Instrument Editor
The Load Multiple Samples dialog provides an additional Zone width field, allowing 
you to specify the width of the newly generated zones.

If you load multiple samples via Zone > Load Multiple samples, the Load Multiple 
Samples dialog also provides a Start Note field, allowing you to specify the width and 
start note of newly generated zones. 

Note:  When loading multiple samples by dragging them from the Finder into the 
Instrument Editor, the Start Note field is not available, as the start key, end key and root 
key are all set to the note that the file was dropped on.

Rubber-banding zones
You can now rubber-band zones in the keyboard and Zone section of the EXS24mkII 
Instrument Editor.
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Envelope Hold parameter
The EXS24mkII envelopes now feature an additional Hold parameter (in the Instrument 
Editor), which can be found in the Group parameters, next to the Attack Offset 
parameter. 

The Hold parameter determines the time period that the envelope will be held at the 
maximum Attack level, before the Decay phase begins.

New Group parameters
AHDSR Offset parameters are now also available for the Filter Envelope, in addition to 
those available for the Amplitude Envelope (see screenshot above).

Next/Previous Instrument menu items
The Instrument menu reinstates the Next Instrument and Previous Instrument menu 
items of earlier Logic versions. 

Remapping of Pitch Bend and Modulation Wheel events
In order to create realistic-sounding performances in an easy and intuitive way, the Jam 
Pack 4 (Symphony Orchestra) Instruments use the modulation wheel to switch 
between articulations (legato, staccato, and so on) and the pitch bend wheel to change 
expression (crescendo, diminuendo, and so on). Further information about this can be 
found in the Jam Pack 4 documentation.

This is achieved by internally remapping pitch bend events to MIDI controller 4 and 
modulation wheel events to MIDI controller 11. To ensure compatibility with the Jam 
Pack 4 instruments, the EXS24 mkII now uses this remapping behavior for all 
instruments that use controller 4 to switch between groups. 

Please note that this new remapping model is also valid for user-built instruments. If 
you use controller 4 to switch between groups, the EXS24 mkII will remap incoming 
pitch bend and mod wheel events to controller 4 or controller 11, respectively. The 
default pitch bend and modulation wheel functionality can not be used. If you don’t 
want to use this remapping model, select a different controller number for group 
switching. 
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Garage Band Instruments 
Two additional GarageBand 2 instruments have been included in Logic Pro 7.1. These 
are the sample-based Hybrid Basic and Hybrid Morph synthesizers.

Both synthesizers are limited to a few powerful, but easy to use parameters, outside of 
the common ADSR, cutoff and resonance options. Experiment with these controls to 
discover how simple it is to create spectacular sounds. 

Of note are the Wave pop-up menus, which allow you to choose the sample set used 
to generate the basic synthesizer sound. 

Each “Wave“ in the Hybrid Morph synthesizer is based on two sample layers. The Morph 
control crossfades between the two sample layers. The Morph Envelope allows you to 
control the morph over time. As an example, setting the Morph parameter to B and the 
Morph Envelope to From A To B, morphs the Wave from A to B in accordance with the 
ADSR envelope settings. 

Note:  It you set the Morph parameter to A and the Morph Envelope to From A to B, 
certain ADSR settings will result in no sound. 

In this context, you can achieve interesting results by using the modulation wheel to 
offset the Morph parameter during live performances. 

In the Hybrid Basic synthesizer, you can use the Wheel to Vibrato and Wheel to Cutoff 
sliders to determine the parameters controlled by the modulation wheel.

New Bass Amp

The Bass Amp plug-in simulates the sound of several famous bass amplifiers. You can 
process bass guitar signals directly within Logic and reproduce the sound of high-
quality bass guitar amplification systems. 
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You can also use the Bass Amp for experimental sound design. You may freely use the 
plug-in on other instruments, as desired—applying the sonic character of a bass amp 
to a vocal or drum part, for example. 

Nine different amplifier models can be accessed via the Model pop-up menu at the top 
of the Bass Amp interface:
• American Basic:  American bass amp model from the 1970’s, equipped with eight 10’’ 

speakers. Well suited for blues and rock recordings. 
• American Deep:  Based on American Basic amp model, with strong lower mid 

frequency (from 500 Hz on) emphasis. Well suited for reggae and pop recordings. 
• American Bright:  Based on the American Basic setting, this setting massively 

emphasizes the upper mids (from 4.5 kHz).
• American Scoop:  Based on American Basic amp model, the American Scoop setting 

combines the frequency characteristics of the American Deep and American Bright, 
with both low mid (from 500 Hz) and upper mid (from 4.5 kHz) frequencies 
emphasized. Well suited for funk and fusion recordings. 

• New American Basic:  American bass amp model from the 1980’s, well suited for 
blues and rock recordings. 

• New American Bright:  Based on the New American Basic model, this setting strongly 
emphasizes the frequency range above 2 kHz. Well suited for rock and heavy metal.

• Top Class DI Warm:  Famous DI box simulation, well suited for reggae and pop 
recordings. Mids, in the broad frequency range between 500 and 5000 Hz, are de-
emphasized.

• Top Class DI Deep:  Based on the Top Class DI Warm model, this setting is well suited 
for funk and fusion:  its mid frequency range is strongest around 700 Hz. 

• Top Class DI Mid:  Based on the Top Class DI Warm model, this setting does not 
emphasize any frequencies, but features a more or less linear frequency range. It is 
suitable for blues, rock, and jazz recordings. 

At the top of the slider section, you will find the Pre Gain control, used to set the pre-
amplification level of the input signal. 

Directly below this slider, you will find the Low, Mid, and High controls. Use these 
sliders to adjust the bass, mid, and treble levels as desired. The additional Mid 
Frequency control allows you to adjust the center frequency of the mid band between 
200 Hz and 3000 Hz.

The Output Level slider serves as a final level control for the Bass Amp output.

New Enhance Timing Effect
The GarageBand 2 audio track editor (Real Instrument tracks) includes a new Enhance 
Timing slider that non-destructively enhances the timing of audio recordings. This 
capability is now available to Logic Pro 7.1 users in the form of the Enhance Timing 
plug-in. 
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The Enhance Timing plug-in offers two parameters:  The Intensity control determines 
the amount of timing enhancement. Audio transients that don’t fall on the grid 
divisions (determined by the value chosen in the Grid menu) are corrected.

The Grid pop-up menu allows you to choose between several grid divisions. As 
described above, the grid divisions serve as reference points for the timing correction 
process.

The Enhance Timing plug-in is designed to “tighten up” loose playing (of recorded 
audio) in a production. It can be used on a variety of material, and works in realtime.

Obviously, this type of real-time quantization has some limitations. It will not work well 
on recordings of performances that have been played too far off the beat. The same is 
true for very complex, layered drum tracks. It will provide noticeable timing 
improvements on reasonably tight percussive and melodic material played in an eighth 
and quarter note feel. If a large amount of timing correction is needed and transients 
are shifted too far, you may notice a number of audio artefacts, so try to strike the 
balance between sound quality and timing enhancement.

Important:  For technical reasons, the Enhance Timing plug-in only works on audio 
tracks and must be inserted in the top Insert slot.

As a tip for triplets, try the 1/12 note setting for played 8th note triplets.

Pitch Correction
The Pitch Correction plug-in features the additional Reference Pitch parameter, which 
enhances the accuracy of the plug-in.

It is often the case that the intonation of a vocal line is slightly sharp or flat throughout 
an entire song. The Reference Pitch parameter addresses this issue at the input of the 
pitch detection process. Set the Reference Pitch to reflect the constant pitch deviation 
in cent values. This allows the pitch correction to perform more accurately. 

The Correction Amount meter display has also been improved:  there is an additional 
red marker that indicates the average correction amount over a longer time period.

There is also a small graphical change:  The Use Global Tuning button was moved from 
the right to the left side of the interface.
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Vocal Transformer
The Vocal Transformer offers three additional parameters in the 001/011 view.
• Glide—determines the amount of time the vocal transformation takes, allowing 

sliding transitions to the set Pitch value. 
• Grain Size—The Vocal Transformer’s algorithm is based on granular synthesis. The 

Grain Size parameter allows you to set the size of the grains, and thus affect the 
precision of the process. Experiment to find the best setting. Try “Auto” first.

• Formants menu—Enables you to determine whether the Vocal Transformer plug-in 
processes all formants (“Process always” option), or only the voiced ones (“Keep 
unvoiced formants” option). The “Keep unvoiced format” option leaves the typical 
sibilant noise of a vocal performance untouched. For some applications, this setting 
will produce a more “natural” sounding transformation effect.

New BPM Counter

The BPM Counter is a useful plug-in that analyzes the tempo of an audio track and 
displays it as a numeric value. As soon as the plug-in is inserted in a track, the 
intelligent detector circuit analyzes the dynamic events in the signal. 

The detector circuit looks for any transients in the input signal. Transients are very fast, 
non-periodical sound events in the attack portion of the signal. The more obvious this 
impulse is, the easier it is for the BPM Counter to detect the tempo. As a result, 
percussive drum and instrumental rhythm tracks (basslines, for example) are very well 
suited for tempo analysis. Pad sounds are a poor choice. 

The LED shows the current state of the analysis process. If the LED flashes, the circuit is 
performing a tempo measurement. When lit, analysis is complete, and the measured 
tempo is displayed. The measurement range is from 80 to 160 beats per minute and the 
measured value is displayed with an accuracy of one decimal place.

The BPM Counter also detects any tempo variation in the signal and tries to analyze it 
accurately. If the LED starts flashing, the BPM Counter has detected a tempo variation 
that has deviated from the last received (or set) tempo. As soon as a new, constant 
tempo is measured, the LED will be solidly lit.

Clicking the LED resets the BPM Counter.
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Mix Slider of Platinum Verb and Tape Delay
The user interface of the Platinum Verb and Tape Delay have been enhanced:  The Dry 
and Wet sliders were moved from the 001/011 view to the Editor view, replacing the Mix 
slider (which is still available in the 001/011 view). 

Test Oscillator
The Test Oscillator plug-in is now also available in the Instrument slot of channel strips. 
The Test Oscillator starts generating the test signal as soon as it is inserted in the 
Instrument slot. You can switch it off by bypassing it. 

Note:  If you insert the Test Oscillator into an Insert slot of an audio channel, you must 
pass audio through this channel, in order to generate a signal. To do so, place any 
Audio Region onto a track, insert the Test Oscillator, and start playback.

Space Designer
The default name for deconvolution files now consists of the source file name, 
appended with an “.SDIR” file extension.

MIDI Learn Mode
The Learn mode of the MIDI controller assignments menu in plug-ins such as the ES2, 
Sculpture, Ultrabeat, EVD6, and the EVB3 now features a 20 second time-out facility:  If 
the plug-in does not receive a MIDI message within 20 seconds, the parameter will 
revert to its original MIDI controller assignment. 

Conversion of EVP73, EXSP24, and ET1 Audio Units Plug-ins
Loading existing songs that contain an EVP73 (AU) plug-in instance will be converted 
to use the GarageBand Electric Piano (if the Audio Unit is unavailable).

Loading existing songs that contain an EXSP24 (AU) plug-in instance will be converted 
to use the internal EXS24 (if the Audio Unit is unavailable).

Loading existing songs that contain an ET1 (AU) plug-in instance will be converted to 
use the internal Tuner plug-in (if the Audio Unit is unavailable).

Replacing Setting-Compatible Plug-ins
When you replace a plug-in with another plug-in that is setting-compatible, the new 
plug-in now automatically uses the setting of the replaced plug-in. 

As an example:  When you replace the Channel EQ with the Linear Phase EQ, the 
inserted Linear Phase EQ uses the same setting as the replaced Channel EQ. The same 
is true if you replace an ES2-based GarageBand instrument with the ES2. It also works 
for most EXS-based GarageBand instruments (exceptions:  Hybrid Morph and Hybrid 
Basic).



  

Support of New Audio Units Type:  Generators
Logic Pro 7.1 supports a new Audio Units plug-in type:  Generators. As the name 
suggests, these Audio Units plug-ins generate audio signals. In contrast to Audio Units 
Instruments, however, they do not require a MIDI signal. All Audio Units Generator 
plug-ins installed on your system can be found in the respective AU Instrument menu’s 
Mono/Stereo/Multichannel > Generators sub menu. 

This means that you can now choose between three different types of Audio Units 
plug-ins (provided you have suitable plug-ins installed on your system) in the 
Instrument menu:
• AU Generators
• AU MIDI Controlled Effects:  As these effects can be controlled via MIDI, they are 

inserted into the Instrument slot of Audio Instrument Objects. The audio signal that 
you would like to process is then selected via the plug-in’s Side Chain menu. 

• AU Instruments

Adjusting Plug-in Parameters With the Mouse Wheel
You can use the mouse wheel to adjust Logic plug-in parameters in Logic Pro 7.1. 

To adjust plug-in parameters with the mouse wheel:
1 Position the mouse cursor over the desired Logic plug-in parameter.

2 Click and move the mouse wheel.
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